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Le présent document comprend des descriptions générales et/ou des caractéristiques techniques 

générales sur la performance des produits auxquels il se réfère. Le présent document ne peut être utilisé 

pour déterminer l'aptitude ou la fiabilité de ces produits pour des applications utilisateur spécifiques et 

n'est pas destiné à se substituer à cette détermination. Il appartient à chaque utilisateur ou intégrateur 

de réaliser, sous sa propre responsabilité, l'analyse de risques complète et appropriée, et d'évaluer et de 

tester les produits dans le contexte de leur l'application ou utilisation spécifique. Ni la société Schneider 

Electric, ni aucune de ses filiales ou sociétés dans lesquelles elle détient une participation, ne peut être 

tenue pour responsable de la mauvaise utilisation des informations contenues dans le présent document. 

Si vous avez des suggestions, des améliorations ou des corrections à apporter à cette publication, 

veuillez nous en informer. 

Aucune partie de ce document ne peut être reproduite sous quelque forme ou par quelque moyen que 

ce soit, électronique, mécanique ou photocopie, sans l'autorisation écrite expresse de Schneider Electric.

Toutes les réglementations locales, régionales et nationales en matière de sécurité doivent être 

respectées lors de l'installation et de l'utilisation de ce produit. Pour des raisons de sécurité et afin de 

garantir la conformité aux données système documentées, seul le fabricant est habilité à effectuer des 

réparations sur les composants.

Lorsque des équipements sont utilisés pour des applications présentant des exigences de sécurité 

techniques, suivez les instructions appropriées. 

La non-utilisation du logiciel Schneider Electric ou d'un logiciel approuvé avec nos produits peut entraîner 

des blessures, des dommages ou un fonctionnement incorrect.

Le non-respect de cette consigne peut entraîner des lésions corporelles ou des dommages matériels.

© 2010 Schneider Electric. Tous droits réservés.
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A propos de ce manuel
Présentation

Objectif du document

Le guide de démarrage rapide utilise un exemple d'application pour décrire les différentes étapes 

permettant d'installer rapidement, de configurer et de commander les démarreurs-moteur TeSys U. Avec 

ce guide de démarrage rapide, vous pouvez facilement configurer un réseau de communication 

Advantys STB, sous réserve que vous connaissiez les bases des automates et logiciels d'application 

(Advantys, Unity Pro). L'exécution de cette tâche ne nécessite pas d'autres documents. 

Pour plus de détails sur les autres fonctionnalités des démarreurs TeSys U, consultez les documents 

associés indiqués ci-dessous.

Champ d'application

Les informations décrites dans ce guide de démarrage rapide sont valables pour le matériel et logiciel 

utilisés dans l'exemple d'application fourni. Les mêmes procédures peuvent être mises en œuvre avec 

différentes versions de matériel et logiciel, dans la mesure où des versions compatibles sont utilisées.

Document à consulter

Vous pouvez télécharger ces publications et autres informations techniques depuis notre site web à 

l'adresse : www.schneider-electric.com.

Commentaires utilisateur

Envoyez vos commentaires à l'adresse e-mail techpub@schneider-electric.com

Titre de documentation Référence

Module de communication TeSys U LULC15 Advantys STB - Manuel d'utilisation 1744083

Variables de communication TeSys U - Manuel d'utilisation 1744082

Mode d'emploi des démarreurs TeSys U LUB/LUS 1629984

TeSys DFB Offer V2 pour Unity Pro - Manuel d'utilisation 1672609

Module d'interface réseau Advantys STB Standard CANopen - Guide d'applications 31003684
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Présentation
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Présentation 
Contenu de ce chapitre

Ce chapitre contient les sujets suivants :

Présentation de l'application

Présentation

L'exemple d'application vous permet de définir les démarreurs directs (Direct On Line - DOL) étape par 

étape, afin de : 

 fournir une protection magnéto-thermique

 commander le moteur et

 obtenir un retour du contacteur et un retour de déclenchement du disjoncteur.

Description de l'application

 Moteur 1 (M1) :

moteur triphasé, classe 10, 5,5 kW (7,5 cv) à 440 V, 50 Hz, courant nominal En = 10,5 A, démarrage 

direct 

 Moteur 2 (M2) :

moteur triphasé, classe 20, 7,5 kW (10 cv) à 440 V, 50 Hz, courant nominal En = 14,7 A, démarrage 

direct avec contrôle à distance de la charge du moteur.

Solution traditionnelle

Le schéma ci-dessous illustre le câblage utilisé dans la solution traditionnelle : toutes les informations de 

commande et de retour sont câblées à travers un automate.

Sujet Page

Présentation de l'application 5

Solution Schneider Electric avec démarreur Tesys U 6

Schéma d'alimentation Schéma de commande
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Présentation
Solution Schneider Electric avec démarreur Tesys U

Schémas d'alimentation et de commande dans la solution Schneider Electric

Unités de contrôle utilisées dans la solution Schneider Electric

La solution Schneider Electric présentée dans ce guide de démarrage rapide utilise le TeSys U pour 

répondre aux différents besoins des clients.

 LUCA12BL est une unité de contrôle standard utilisée avec le moteur 1 pour les besoins de base :

 commande à distance un moteur (démarrage/arrêt)

 fournit les informations d'état (prêt, en marche, défaut)

 LUCD18BL est une unité de contrôle avancée utilisée avec le moteur 2 pour les besoins avancés, en 

plus des besoins standards :

 alarme

 réarmement automatique et à distance par le bus

 indication de la charge moteur

 différenciation des défauts

Schéma d'alimentation Schéma de commande

1. Modicon M340 Processeur BMXP342010 avec bus 

maître CANopen intégré

2. Connecteur TSXCANKCDF90T

3. STBNCO2212 Advantys STB Module d'interface 

réseau standard pour CANopen

4. raccordement de bobine précâblée LU9BN11L

5. LU9RCD10 Câble de raccordement de bus au premier 

TeSys U

6. Câble de raccordement de bus LU9RDD10 entre les 

modules Advantys STB

7. LU9RFL15 Obturateur de ligne TeSys U

A
1

A
2

LUCAppBL

5.5 kW

Q1
KM1

M1

440 V 50 Hz

TeSys U TeSys U

A
1

A
2

A
1

A
2

A
1

A
2

LUCDppBL

LULC15

Advantys
bus
24 Vdc

Advantys
bus
24 Vdc

LULC15

7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

1

4 4
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TeSys UTeSys U
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Présentation
Architecture du système TeSys U

L'architecture suivante présente les principaux composants du système TeSys U monté sur une plaque :

Légende Référence commerciale Description

1 Modicon M340 Programmable Logic Controller (automate programmable industriel)

Îlot STB comprenant les composants suivants :

2 TSXCANKCDF90T Connecteur SUB-D9 angle droit CANopen en position ON

3 STBNCO2212 Module d'interface réseau (Network Interface Module, NIM) avec bus 

CANopen

4 STBPDT3100 Module de distribution d'alimentation STB pour 24 V

5 STBDDO3200 Module de sortie numérique

6 STBXBE1100 Module d'extension de fin d'îlot (End of segment, EOS)

7 LU9RCD10 Câble de raccordement de bus, coudé/droit, avec un connecteur de câble 

d'extension de bus d'îlot à chaque extrémité, fournissant des signaux de bus 

et une alimentation électrique interne, permettant la connexion du premier 

module de communication TeSys U (maximum 1 m (39,4 in.) à couper selon 

la taille du réseau).

8 LUB12 Base puissance TeSys U

9 LUCA12BL Unité de contrôle standard

10, 13 LULC15 Module de communication Advantys STB

11 LUB32 Base puissance TeSys U

12 LUCD18BL Unité de contrôle avancée

14 LU9RFL15 Adaptateur de fin de ligne TeSys U

15 LU9RDD10 Câble de raccordement de bus, droit/droit, avec un connecteur de câble 

d'extension de bus d'îlot à chaque extrémité, fournissant des signaux de bus 

et une alimentation électrique interne, permettant des connexions entre les 

modules de communication LULC15 (maximum 1 m (39,4 in.) à couper selon 

la taille du réseau).

16 LU9BN11L Raccordement de bobine précâblée (en option) ou  

17 Connexion standard 

fournie avec LULC15

Bornier enfichable, pour contrôle fil à fil pour des bornes A1/A2

1 2 3 5 64 7 8 9 10

14

15

11

12

13

16 / 17
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Présentation
Outils logiciels

Les outils logiciels suivants doivent être utilisés pour définir les applications. Leur utilisation nécessite une 

connaissance de base.

Réseau de bus de terrain

Protocole : CANopen

Débits en bauds : 500 kbps

Configuration de stratégie de repli pour le TeSys U sur le sous-réseau STB

En cas de perte de communication avec l'automate, la stratégie de repli permet d'actionner un moteur de 

différentes façons. Définissez le paramètre 682 sur l'une des valeurs suivantes :

La stratégie de repli adaptée à l'application est :

 Valeur 1 = Figé pour le moteur 1

 Valeur 2 = Arrêt forcé pour le moteur 2

Référence commerciale Logiciel libre Description

STB SPU 1000 — Advantys Logiciel de configuration V2.5 pour le 

système E/S distribué Advantys STB.

UNY SPU EFM CD40 — Unity Pro Extra Large Logiciel de programmation 

V4.0 pour automate M340.

— Fichier 

STBNCO2212_0301E.eds
Fichier Electronic data sheet (EDS) utilisé par le 

logiciel de configuration Unity Pro XL pour 

manipuler les équipements correctement. 

Téléchargez le fichier .eds sur le site Web 

www.schneider-electric.com.

— Bibliothèque DFB, avec 

Ctrl_cmd_u

Contrôle/commande cyclique TeSys U. 

Téléchargez la bibliothèque des DFB TeSys U 

sur le site Web www.schneider-electric.com.

Valeur Mode de repli Description

0 Désactivée Aucune stratégie appliquée. Non recommandé.

1 Figé En cas de détection de perte de communication, le moteur conservera son 

statut :

 Si le moteur est en marche, il continuera de tourner.

 Si le moteur est arrêté, il restera dans cet état.

Aucune modification du statut de commande n'est autorisée. Une nouvelle 

commande ne sera prise en compte qu’après un réarmement sur perte de 

communication (703.3)

2 Arrêt forcé (valeur par 

défaut)

Le moteur est forcé de s'arrêter.

Sortie OA1= 0

Sortie OA3 = 0

3 Inchangé Les modifications du statut de commande sont autorisées. Une nouvelle 

commande sera prise en compte même avant un réarmement sur perte de 

communication (703.3)

4 Forcé en marche en sens 

direct

Sortie OA1= 1 (direct) 

Sortie OA3 = 0

5 Forcé en marche en sens 

inverse

Sortie OA1= 0

Sortie OA3 = 1 (sens inverse)
8 1672608 01/2010
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Configuration du TeSysU
Contenu de ce chapitre

Ce chapitre contient les sujets suivants :

Réglages LUCA12BL et LUCD18BL

Régler le courant sur les unités de contrôle

La figure ci-dessous illustre comment régler le courant sur l'unité de contrôle à l'aide d'un tournevis (ici 

LUCA12BL) :

Valeurs de réglage du courant

Le tableau ci-dessous présente les réglages pour le LUCA12BL (unité standard) et le LUCD18BL (unité 

avancée) :

Sujet Page

Réglages LUCA12BL et LUCD18BL 9

Réglages des connecteurs, du débit en bauds et de l'adresse du LULC15 10

4.00A

LULC15

5.00A

7.00A

9.00A

12.0A

3.00A

LUCA / LUCD
TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Unité de contrôle Moteur Plage de réglage du 

courant

Puissance nominale 

du moteur

Valeur de réglage du 

courant = Courant 

nominal du moteur

LUCA12BL M1 3...12 A 5.5 kW (7.5 hp) 10.5 A

LUCD18BL M2 4.4...18 A 7.5 kW (10 hp) 14.7 A
9



Configuration du TeSys U
Réglages des connecteurs, du débit en bauds et de l'adresse du LULC15

Présentation

Les connecteurs sous le module de communication LULC15 sont les suivants :

1 Bornier Entrée/Sortie et 24 V CC

2 Bus OUT (sortie logique 1)

3 Bus IN (entrées logiques 1 et 2)

4 Sorties COM, OA1, OA3

Réglages de débit en bauds et d'adresse

Les paramètres de communication, dont les réglages d'adresse et de débit en bauds, du module de 

communication LULC15 sont définis automatiquement.

4

3

2

1
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Configuration d'un réseau de communication vers un automate
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Configuration d'un réseau de communication 

vers un automate
Présentation

Ce chapitre décrit de façon détaillée comment établir une communication vers un automate.

Les 2 outils logiciels suivants sont nécessaires pour établir une communication vers un Modicon M340 :

 Advantys

 Unity Pro

Contenu de ce chapitre

Ce chapitre contient les sujets suivants :

Sujet Page

3.1  Configuration du TeSys U sur le réseau Advantys STB avec Advantys et Unity Pro 12

3.2.  Configuration des DFB avec l'application 17
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Configuration d'un réseau de communication vers un automate
3.1  Configuration du TeSys U sur le réseau Advantys STB avec Advantys et Unity Pro

Processus de configuration

1)  Téléchargement et installation des fichiers EDS

Les fichiers EDS correspondants doivent être présents dans Unity. Le tableau suivant présente la 

procédure de téléchargement et d'installation des fichiers EDS et icône associés au Tesys U à partir du 

site Web www.schneider-electric.com, si nécessaire :

Étape Action

1 Ouvrez le site Web Schneider Electric : www.schneider-electric.com.

2 Saisissez Advantys STB dans le champ de recherche.

3 Dans la section Produit Ranges, cliquez sur Advantys STB.

4 Cliquez sur l'onglet Téléchargements puis sur Logiciels.

5 Sélectionnez STBNCO2212 CANopen .eds and .dib Files 2/8/06 et téléchargez le fichier 

stbnco2212_canopen_eds_1_2006.zip.

6 Extraire le fichier stbnco2212_canopen_eds_1_2006.zip sur votre disque dur. Il contient le fichier 

STBNCO2212_0301E.eds.

7

À partir du bouton démarrer, sélectionnez Tous les programmes et allez sur Schneider Electric 

→ Unity Pro → Hardware catalog manager.

8 Dans la fenêtre Hardware Catalog Manager, sélectionnez Edit → Add.

9 Dans la fenêtre qui s'affiche, naviguez jusqu'au fichier STBNCO2212_0301E.eds et sélectionnez-le.

10 Confirmez en cliquant sur Open.

11 Dans la fenêtre Device Profile, vérifiez que Distributed I/Os est sélectionné dans le champ Family, 

puis confirmez en cliquant sur OK.

Résultat : l'équipement apparaît dans la fenêtre Hardware Catalog Manager.

12 Dans la fenêtre Hardware Catalog Manager, cliquez sur le bouton Build Catalog puis cliquez sur 

Close.
12 1672608 01/2010



Configuration d'un réseau de communication vers un automate
2)  Configuration de l'îlot STB avec le logiciel Advantys

La partie du processus de configuration avec le logiciel Advantys est décrite ci-dessous :

Étape Action

1 Démarrez le logiciel Advantys V2.5.

2 Cliquez sur l'icône STB et choisissez la langue.

3 À partir du menu File, créez un nouvel espace de travail comprenant un fichier d'îlot.

4 Vérifiez que l'îlot est déverrouillé : l'icône en forme de clé dans la barre d'outils ne doit pas être 

sélectionnée.

5 Configurez l'îlot STB à partir des modules disponibles dans le dossier STB - Catalog du Catalog 

Browser.

Sélectionnez puis double-cliquez sur les modules dans l'ordre suivant :

 Networking → STBNCO2212 - V3.xx pour le module d'interface réseau (NIM) 

 Power → STBPDT3100 - V1.xx pour le module de distribution d'alimentation (PDM)

 Digital Output → STBDDO3200 - V1.xx pour le module E/S Advantys

 Accessories → STBXBE1100 - V1.xx pour la fin d'îlot (EOS), sachant qu'un équipement TeSys U 

est le dernier module sur le bus d'îlot.

Résultat : les modules sélectionnés s'affichent dans l'éditeur d'îlot.

NOTE : Si les modules de votre application ne sont pas disponibles dans le catalogue du matériel, 

mettez ce dernier à jour comme suit :

 Ouvrez le site Web Schneider Electric : www.schneider-electric.com.

 Saisissez Advantys Database Update dans le champ de recherche.

 Dans la section Logiciel, cliquez sur Advantys Database Update V 2.53 for Configuration 

Software.

 Téléchargez le fichier advantys_csw_2501_database_update_253_english.exe.

 Double-cliquez sur advantys_csw_2501_database_update_253_english.exe.

 Suivez la procédure pour installer le fichier.

 À partir du logiciel Advantys, sélectionnez la commande de menu Options → Settings.

 Sous Path settings, définissez le chemin pour EDS files import en parcourant votre disque dur 

jusqu'au dossier dans lequel vous avez installé le fichier .exe.

 Cliquez sur OK pour fermer la boîte de dialogue Settings.

6 Ajoutez les 2 systèmes TeSys U dans l'ordre suivant en sélectionnant puis double-cliquant sur l'étiquette :

 Preferred → TeSys U Sc St - V1.xx pour le TeSys U standard

 Preferred → TeSys U Sc Ad - V1.xx pour le TeSys U avancé

NOTE : 

 Les lettres Sc signifient Starter-Controller (démarreur-contrôleur).

 Les lettres St et Ad signifient respectivement unité de contrôle Standard et Advanced (avancée).

7 Ajoutez l'équipement de terminaison en sélectionnant Accessories → TeSys U LU9RFL15 - V1.xx, 

puis en double-cliquant sur le nom de l'adaptateur de fin de ligne.
1672608 01/2010 13



Configuration d'un réseau de communication vers un automate
3)  Configuration du réseau d'application avec le logiciel Unity Pro XL

Poursuivez le processus de configuration avec le logiciel Unity Pro XL, comme décrit ci-dessous :

8 Double-cliquez sur chaque image TeSys U dans l'ordre. Dans la boîte de dialogue de configuration qui 

s'affiche, configurez la stratégie de repli sur perte de communication : déroulez la liste Setting dans 

l'onglet Parameters, puis sélectionnez Fallback Strategy (682). Sous Configured Value :

 Pour TeSys U Sc St, configurez la stratégie de repli sur perte de communication sur Frozen dans 

la liste déroulante, puis confirmez en cliquant sur OK.

 Pour TeSys U Sc Ad, conservez la stratégie de repli sur perte de communication par défaut : 

Forced Stop.

9 Enregistrez l'application puis cliquez sur l'icône Build.

Résultat : la fenêtre journal doit afficher le message suivant : “Build completed successfully”

10 Sélectionnez File → Export [project name] et exportez votre projet en tant que fichier .dcf.

11 Enregistrez à nouveau l'application puis quittez le logiciel Advantys.

Étape Action

Étape Action

1 Démarrez le logiciel Unity Pro XL V4.0.

2 Configurez le processeur de l'automate Modicon M340 :

 A partir du menu File (fichier), créez un nouveau projet.

 Dans la fenêtre New Project, déroulez la liste Modicon M340 et sélectionnez BMX P34 2010 (CPU 

340-20 Modbus CANopen).

 Confirmez en cliquant sur OK.

3 À partir de la Structural view du Project Browser, sélectionnez Configuration → 3 : CANopen. 

4 Dans l'onglet CANopen , double-cliquez sur l'équipement :

Une boîte de dialogue New Device s'ouvre.

5 Dans la fenêtre New Device , définissez la configuration du module d'interface réseau (NIM) CANopen 

comme suit :

 Sélectionnez CANopen drop → Distributed I/Os → STB_NCO_2212

NOTE : si le module d'interface réseau de l'application n'apparaît pas dans la liste des E/S distribuées, 

vous devez télécharger et installer les fichiers .eds correspondants (voir page 12).

 Réglez Topological Address sur 4.

 Confirmez en cliquant sur OK.
14 1672608 01/2010



Configuration d'un réseau de communication vers un automate
6 À partir de la Structural view du Project Browser, sélectionnez Configuration → 3 : CANopen → 

4 : CANopen drop → 0.0 : STB_NCO_2212, puis double-cliquez sur le nom du module d'interface 

réseau (NIM). L'écran STB_NCO_2212 s'affiche dans un nouvel onglet.

7 Dans l'onglet PDO, marquez les PDO vides puis cliquez sur le bouton Import DCF... et naviguez 

jusqu'au fichier .dcf exporté lors de la configuration de l'application dans Advantys.

Résultat : les PDO s'affichent à l'écran avec les adresses topologiques associées.

NOTE : Consultez les manuels d'utilisation Module de communication TeSys U LULC15 Advantys STB 

et Variables de communication TeSys U pour plus de détails sur comment nommer les adresses 

topologiques de façon à éviter de programmer avec des noms qui n'apportent aucune information sur 

les contenus de l'emplacement de mémoire.

Par exemple : dans l'application, les symboles suivants sont utilisés pour programmer le DFB du 

moteur 1 (TeSys U standard) :

 Entrée mappage de données :

 PDO4 : symbole reg_455_M1 au lieu de %IW\3.4\0.0.0.96

 Sortie mappage de données :

 PDO3 : symbole reg_704_M1 au lieu de %QW\3.4\0.0.0.96

 PDO3 : symbole reg_703_M1 au lieu de %QW\3.4\0.0.0.97

8 À partir de la Structural view du Project Browser, sélectionnez Configuration → 0 : PLC bus → 

0 : BMX XBP 0800 → 0 : BMX P34 2010 → CANopen. L'écran CANopen communicator head 

s'affiche dans un nouvel onglet.

9 Sélectionnez Build → Rebuild All Project.

NOTE : Un message s'affiche dans la zone Rebuild All Project au sujet du nombre E/S de mots et de 

bits réservés. Retournez à l'écran CANopen communicator head et entrez les valeurs comme indiqué 

dans le message.

Configurez les options conformément à l'exemple d'application :

 Définissez la vitesse de transmission jusqu'à 500 kbauds.

 Nb. of words (%MW) doit être 278 pour les entrées et 244 pour les sorties.

 Index of 1st%MW doit être 0 pour les entrées et 278 pour les sorties.

 Nb. of bits (%M) doit être 0 pour les entrées et sorties.

10 Sélectionnez Edit → Validate pour valider la configuration.

11 Sélectionnez Build → Rebuild All Aroject pour recréer le projet. Lorsque les valeurs sont correctes, 

l'état NOT BUILT devient BUILT.

12 Enregistrez l'application avec un nom spécifique puis quittez le logiciel Unity.

Étape Action
1672608 01/2010 15



Configuration d'un réseau de communication vers un automate
4)  Réglage du débit en bauds et de l'adresse de nœud de l'îlot Advantys STB 

Les commutateurs rotatifs sur le module NIM STBNCO2212 CANopen sont utilisés pour le réglage du 

débit en bauds et de l'adresse de nœud de l'îlot Advantys STB.

Les 2 commutateurs rotatifs sont situés à l'avant du module NIM CANopen, en dessous du port de 

connexion du bus de terrain. Chaque commutateur propose 16 positions.

Procédez comme suit pour régler le débit en bauds puis l'adresse de nœud de l'îlot Advantys STB : 

5)  Exécution d'un test fonctionnel du réseau de communication, notamment les produits et l'automate M340 

Étape Action

1 Réglez le débit en bauds de l'îlot Advantys STB sur 500 kbauds en tournant les commutateurs rotatifs 

sur le module NIM STBNCO2212 CANopen dans l'ordre :

 Réglez le commutateur du bas (BAUD RATE) sur une position non marquée

 Réglez le commutateur du haut (TENS) sur le débit en bauds sélectionné : 5

2 Mettez l'îlot sous tension pour permettre au module NIM de lire le réglage du débit en bauds.

3 Mettez l'îlot hors tension.

4 Réglez l'adresse de nœud de l'îlot Advantys STB sur 4 en tournant les commutateurs rotatifs sur le 

module NIM STBNCO2212 CANopen :

 Réglez le commutateur du bas (ONES) sur 4

 Réglez le commutateur du haut (TENS) sur 0

5 Mettez l'îlot sous tension pour permettre au module NIM de lire le réglage de l'adresse.

Étape Action

1 Connectez un câble entre l'îlot CANopen et l'automate M340.

2 Par le port USB sur votre ordinateur, branchez un câble (par ex. TSXPCX3030) sur l'automate M340.

3 Mettez l'automate M340 sous tension.

4 Cliquez sur Connect dans le logiciel Unity Pro XL.

5 Cliquez sur le menu PLC : la fenêtre Transfer Project to PLC s'ouvre. Cliquez sur le bouton Transfer.

6 Mettez les 2 systèmes TeSys U sous tension : la DEL verte COM à l'avant du LULC15 clignote puis reste 

allumée. La communication fonctionne correctement.
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3.2.  Configuration des DFB avec l'application

Présentation

Les DFB (Derived Function Blocks - Blocs fonction dérivés) TeSys ont été développés pour faciliter et 

optimiser l'intégration des démarreurs-contrôleurs TeSys U dans les applications d'automate.

Le DFB Ctrl_cmd_u est destiné au contrôle et à la commande d'un seul démarreur-contrôleur TeSys U 

(jusqu'à 32 A/15 kW ou 20 hp) via les échanges cycliques de données sur un réseau CANopen.

Les étapes de configuration du DFB sont les suivantes :

1. Téléchargement des fichiers DFB

2. Installation du DFB dans Unity Pro

3. Extraction de votre projet et de l'application DFB dans Unity Pro

Pour de plus amples informations, reportez-vous au manuel d'utilisation TeSys DFB Offer V2 pour 
Unity Pro.

1)  Téléchargement des fichiers DFB

Le tableau suivant présente la procédure de téléchargement des TeSys DFB à partir du site Web 

www.schneider-electric.com :

2)  Installation du DFB dans Unity Pro

Étape Action

1 Accédez au site Web de Schneider Electric à l’adresse suivante : www.schneider-electric.com

2 Saisissez TeSys U dans le champ de recherche.

3 Dans la section Produit Ranges, cliquez sur TeSys U.

4 Cliquez sur l'onglet Téléchargements puis sur Logiciels.

5 Sélectionnez TeSys DFB Library for UnityPro et téléchargez le fichier .zip sur votre disque dur.

Étape Action

1 Extraire le contenu du fichier tesys library for unitypro-1.0.2.zip sur votre disque dur puis double-cliquez 

sur le fichier Setup.exe.

2 Sélectionnez la langue pour l'installation.

3 Dans l'assistant d'installation de TeSys Library, cliquez sur Suivant 5 fois.

4 Acceptez, les termes de la licence puis cliquez sur Suivant.

5 Saisissez vos informations client puis cliquez sur Suivant deux fois.

6 Sélectionnez une ou plusieurs langues pour l'application, dont une langue par défaut, puis cliquez sur 

Suivant.

7 Cliquez sur Installer pour démarrer l'installation.

8 Dans la fenêtre qui s'affiche, sélectionnez la version de la bibliothèque Unity Pro et la famille à installer.

9 Une boîte de dialogue s'ouvre avec le message suivant : “The Installation Wizard has successfully 

installed TeSys Library”. Quittez l'assistant d'installation.
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3)  Extraction de votre projet et de l'application DFB dans Unity Pro

Caractéristiques d'entrées

Le tableau suivant décrit les entrées des DFB ainsi que leur disponibilité selon l'unité de contrôle :

Étape Action

1 Démarrez le logiciel Unity Pro.

2 À partir du menu Tools, sélectionnez le sous-menu Type Library Manager. Cliquez sur lAccess 

Assistant (Atteindre l'assistant). Sélectionnez le dossier Ctrl_cmd_u et déplacez-le à droite jusqu'à la 

zone intitulée Objects to get :

Cliquez sur Copy into project (Copier dans le projet).

3 Cliquez avec le bouton droit de la souris dans la fenêtre de section puis sélectionnez FFB Input 

Assistant.... Une boîte de dialogue Function Input Assistant vide s'ouvre.

4 Sélectionnez l'icône suivante à côté du champ FFB type :

5 Dans la boîte de dialogue Function Input Assistant: FFB Selection, naviguez jusqu'au DFB 

Ctrl_cmd_u.

6 Sélectionnez Ctrl_cmd_u, puis confirmez avec OK.

7 Cliquez n'importe où dans la fenêtre de section : la représentation graphique DFB s'affiche.

Entrée Type Plage Valeur 

par défaut

Description LUCA LUCD

Reg_455 INT 0...65535 0 Liaison vers le registre 455 de données d'entrée 

cycliques

√ √

Run_fwd EBOOL 0...1 0 Commande de marche directe du moteur √ √

Run_rev EBOOL 0...1 0 Commande de marche inverse du moteur √ √

Rst_flt EBOOL 0...1 0 Réinitialisation (en cas de défaut interne du 

module de communication, réinitialise le module 

de communication aux paramètres d'usine).

√ √

Rst_warn EBOOL 0...1 0 Alarme de réarmement (par exemple, perte de 

communication)

√ √

Ther_ov_test EBOOL 0...1 0 Test de défaut de surcharge thermique automatique   

Trip_tst EBOOL 0...1 0 Test de déclenchement de surintensité via le bus 

de communication
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Caractéristiques de sorties

Le tableau suivant décrit les sorties des DFB ainsi que leur disponibilité selon l'unité de contrôle :

Programmation des DFB 1 pour le moteur 1

Sortie Type Plage Valeur par 

défaut

Description LUCA LUCD

Reg_704 INT 0...65535 0 Liaison vers le registre 704 de données de 

sortie cycliques

√ √

Reg_703 INT 0...65535 0 Liaison vers le registre 703 de données de 

sortie cycliques

√ √

Ready EBOOL 0...1 0 Système disponible<:hs>: la poignée rotative 

est tournée en position On et aucun défaut 

n'est détecté

√ √

Closed EBOOL 0...1 0 Etat du pôle : fermé √ √

Tripped EBOOL 0...1 0 Système déclenché : la poignée rotative est 

tournée en position Trip

√ √

Fault EBOOL 0...1 0 Tous les défauts √ √

Alarm EBOOL 0...1 0 Toutes les alarmes √ √

Rst_auth EBOOL 0...1 0 Réinitialisation du défaut autorisée  √

Starting EBOOL 0...1 0 Démarrage en cours :

1 = le courant croissant est supérieur à 10 % 

FLA

0 = le courant décroissant est inférieur à 

150 % FLA

 √

Running EBOOL 0...1 0 Moteur en marche avec détection d'un 

courant, si supérieur à 10 % de FLA

 √

Avg_curr INT 0...200 0 Courant moteur moyen (% FLA)  √

Étape Action

1 Nommez les registres d'automate (%IW..., %QW...) correspondant aux registres TeSys U (455, 703 et 

704).

Pour le nœud 1 (TeSys U_Sc_St) :

 Reg_455_M1: %IW\3.4\0.0.0.96

 Reg_704_M1: %QW\3.4\0.0.0.96

 Reg_703_M1: %QW\3.4\0.0.0.97

2 Associez l'entrée DFB1 Run_fw à la condition de démarrage du moteur 1.

3 Associez les sorties DFB 1 aux variables d'automate pour l'utilisation dans le programme :

 Sortie DFB 1 fermée = position du contacteur KM1

 Sortie DFB 1 déclenchée = position déclenchée du Q1 TeSys U

4 Vérifiez que le DFB 1 pour le moteur 1 s'affiche comme suit :

1 Non applicable

2 Applicable mais non utilisé, peutt être géré par l’application de l’automate.
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Programmation des DFB 2 pour le moteur 2

Étape Action

1 Nommez les registres d'automate (%IW..., %QW...) correspondant aux registres TeSys U (455, 703 et 

704)

Pour le nœud 2 (TeSys U_Sc_Ad) :

 Reg_455_M2: %IW\3.4\0.0.0.98

 Reg_704_M2: %QW\3.4\0.0.0.99

 Reg_703_M2: %QW\3.4\0.0.0.100

2 Associez l'entrée DFB 2 à la condition de démarrage du moteur 2.

3 Associez les sorties DFB 2 aux variables d'automate pour l'utilisation dans le programme :

 Sortie DFB 2 fermée = position du contacteur KM2

 Sortie DFB 2 déclenchée = position déclenchée du Q2 TeSys U

4 Associez la sortie DFB 2 Avg_curr à un registre d'automate pour utiliser le courant moyen du moteur 2 

dans le programme.

5 Vérifiez que le DFB 2 pour le moteur 2 s'affiche comme suit :

1 Non applicable

2 Applicable mais non utilisé, peutt être géré par l’application de l’automate.
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